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Introduction: Introducing Higher Administration and IT

Communication in administration

The purpose of this unit is to enable learners to develop a range of IT skills (focusing 
particularly on presentation software) for researching and communicating complex 
information to others. This will enable learners to communicate information, taking 
account of the needs of the audience. Learners will develop an understanding of barriers 
to communication and ways of overcoming them to ensure communication is understood. 
This unit will also develop learners’ knowledge and understanding of how to maintain the 
security and confidentiality of information.

THE IMPORTANCE OF ADMINISTRATION
A successful business needs knowledgeable and highly-skilled administrators who can 
provide high-level administrative support to ensure the smooth and efficient running of 
the organisation.

An Administrative Assistant has to manage the day-to-day operations of an office. 
This could range from undertaking basic routine tasks to taking responsibility at a 
more senior level and overseeing the work of junior staff; this is all dependent on the 
size and structure of the organisation. Administrative support could therefore involve 
keyboarding, reading and replying to e-mails, composing letters and memoranda, 
supervising staff (including planning their work assignments), customer care, dealing 
with confidential matters (staff-related or otherwise), writing reports, organising 
meetings, implementing and developing organisational policies and procedures, project 
management and Health and Safety.

Breakthrough developments in information technology (IT) and the increased use of 
emerging technologies have had a major impact on the way many administrative tasks 
are undertaken and indeed in the way organisations function and communicate. As office 
automation and the use of IT to execute various office procedures continues to develop, 
there will be an increased need for skilled Administrative Assistants.

This Higher Study Guide will help develop your knowledge and understanding of the role 
Administrative Assistants play in modern business organisations. Practical activities will 
also help you develop the IT skills necessary to organise, analyse, store, and present and 
communicate business information using appropriate software applications. This guide 
will also help you to develop and apply skills for learning, skills for work and skills for life.

INTRODUCING HIGHER ADMINISTRATION 
AND IT

INTRODUCTION

HIGHER COURSE CONTENT
The Higher course contains three units of study:

Administrative theory and practice

This unit enables you to develop an in-depth knowledge and understanding of 
administration in, and the impact of IT on, the workplace. You will acquire an in-depth 
knowledge and understanding of the factors contributing to the effectiveness of 
the administrative function, such as efficient time and task management, complying 
with workplace legislation, successful teams, organising effective meetings and good 
customer care.

IT solutions for administrators

The purpose of this unit is to develop learners’ skills in IT and in the organisation and 
management of information in administration-related contexts. Learners will develop 
the ability to utilise a range of functions within IT applications covering word processing, 
spreadsheets and databases, and to use them to analyse, process and manage information 
in order to create and edit relatively complex business documents. This unit, in 
particular, will be supported with a range of tasks on the Digital Zone to allow learners to 
confidently develop and apply their ICT skills at an advanced level.

contd

COURSE ASSESSMENT – EXTERNAL ASSESSMENT
Theory question paper

The question paper is worth 50 marks (42 per cent of the total mark). The question paper 
consists of two sections:

•	 Section 1 – This section has 10 marks and consists of a set of mandatory questions based 
on a given stimulus. The questions can come from any areas covered in the course.

•	 Section 2 – This section has 40 marks and consists of mandatory questions. Questions 
from each section of the course will be sampled, ensuring there is a balanced 
coverage across the course.

The question paper is set and marked by SQA. Learners will complete this in one hour and 
thirty minutes. A specimen examination paper is available to learners in the Digital Zone.

Practical assignment

The purpose of this is to address challenge and application. It assesses your ability to 
apply problem-solving and advanced IT skills in the context of a complex scenario.

This assignment is set by SQA on an annual basis and conducted under a high degree of 
supervision and control within presenting centres. You will complete the assignment in 
two hours. The assignment is worth 70 marks (58 per cent of the total mark).

EXAMINATION HINTS – QUESTION PAPER
Before you start answering questions in the external examination paper, you should 
identify the key ‘command word’ used in each question. This will ensure that you tailor 
your response to the demands of the question being asked. The table below outlines the 
key command words which could be used in the final external examination.

COMMAND WORD MEANING

State Listing or bullet points would be acceptable here.

Suggest More than just naming or stating. Put forward a recommendation or advise on a possible course of action.

Outline Identify key features and provide a brief description where appropriate.

Describe Give a description and use examples where possible as part of the description.

Explain Give a definition and then an example as to how something may or may not be affected.

Discuss Give advantages and disadvantages where possible. Use examples to expand your answer, and if possible 
give a conclusion to your answer.

Compare You must be able to compare the similarities or differences between the items, again giving a conclusion if 
necessary. A key word that you can use in this type of question is ‘whereas’.

Justify You must be able to give reasons why a certain course of action is being taken.

Implications You should be able to state what the likely outcome of a particular action will be in the longer term, either 
on a person or on an organisation.

Consequences You must be able to identify the initial impact of the action being followed.
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VIEWS FOR EDITING YOUR PRESENTATION
Normal view

This is the main view and it is sub-divided into four working areas:

•	� Slides tab – lets you see each slide as a thumbnail image. You can then scroll through 
to see any changes you have made to the overall design. Change the order of slides 
by dragging them up or down; add new slides by clicking New Slide and selecting the 
desired layout; delete slides using the Delete key. 

•	� Outline tab – lets you edit your presentation in a ‘text only’ environment, providing 
a more efficient way to draft text. Moving text between slides is easy, as is changing 
the order of the slides. You can also print the Outline View of your presentation. The 
Outline pane can be resized to see more information – simply position the mouse 
pointer over the right-hand edge until it changes to , click and drag the pointer 
until it reaches the desired size. As you type, the text appears on the slide and in 
the Outline View. Using your keyboard, new lines can be created, bullets can be 
promoted/demoted and new slides can be inserted.

Promoting and Demoting changes the importance of the lines of text that you are editing: 

•	 If you have a main point you’d like to become a sub-point, demote it!
•	 If you have a sub-point you’d like to become a new slide, promote it! 

To increase the importance of text, right-click and select Promote or press Shift + Tab. 
The text moves left and the bullet point changes/disappears.

To create a new line at the same level, press the Return key.

Another way to do this is by using the Decrease 
List Level and Increase List Level buttons ( )  
on the Home tab.

To rearrange the order of the bullets in a list right-
click and select either Move Up or Move Down. 

To see only the structure of the slides and not 
the detail, or to move slides around the Outline 
pane, right-click and select Collapse for one slide 
or Collapse All for every slide. To show the detail 
again, click on Expand/Expand All.

EDITING A PRESENTATION

PRESENTATION SOFTWARE
•	 Slide pane (upper-right of window) – displays a large view of the slide 

you are working on. From here, you can add text or any of a wide variety 
of graphics, video clips and animations, sounds and so on.

•	 Notes pane (below Slide pane) – click this pane to add notes relating to 
the current slide that might be useful to refer to during your presentation 
or reading a hard copy of it later. Notes can also be printed or posted on 
a Web page. The Notes pane can be adjusted to see all the text or it can 
be opened from the View menu. Each Notes Page shows a slide thumbnail, 
together with the notes that accompany that slide. In Notes Page View, you 
can embellish your notes with charts, pictures, tables or other illustrations 
and you can see how your notes pages will print. Here you can also check 
and change the headers and footers of your notes. 

If you want to print an outline of your presentation, with the text (as it appears 
in Outline View) but no graphics or animation, you should first click the File 
tab and then click Print. Click Full Page Slides under Settings, then choose 
Outline from the list under Print Layout. Finally, click Print at the top.
 To print Notes – go 

to the File tab, click 
on Print then select 
Notes Pages from 
the drop-
down menu.

The notes pages will 
be printed with a 
slide thumbnail.

To print notes pages without slide thumbnails, open each slide in Notes Page View, click 
the slide thumbnail and then press the Delete key before following the printing steps above.

Slide master
 

Slide Master View (on the View tab) lets you modify slides and make changes to layouts 
which will affect every slide in the presentation – for example insert the company logo on 
all slides. This saves a lot of time. Themes have built-in slide layouts and background 
graphics and you can edit these in Slide Master View. You can also modify individual 
slide layouts to change any slides using these particular layouts.

The first slide in the Navigation pane is the Slide Master and any changes made to this 
slide will affect the entire presentation.

Hovering the mouse over the remaining layouts 
will show which slides use which particular layouts. 
Changes to a slide layout will only be applied to 
those slides using that layout in your presentation.

After changing the Slide Master, review to see 
how the changes affect each slide. You may find 
some of your slides don’t look right and more 
changes are needed. Click Close Master View to 
return to your presentation.

PowerPoint is software that uses slides to create and build dynamic slide presentations that can 
include text, bulleted lists, images, charts, animation, narration, images and video. You can add 
as many slides as you want to a presentation and you can view or play back your presentation 
at any time. You can also print the presentation in handout format, providing hard copy for the 
audience to annotate and take away for future reference.

You can print only one slide 
thumbnail with notes per 
printed page.

When editing an existing 
presentation in Slide Master 
view it is sometimes easier 
to see which layouts have 
been used if you first delete 
those layouts ‘used by 
no slides’.

 

 

  

 

 

 

Promoting text to its 
highest level will create 
a new slide containing 
that text!

contd

To test your knowledge of 
presentation software, head 
to www.brightredbooks.net

Check out the clip at 
www.brightredbooks.
net for a tutorial on 
using PowerPoint.

It is often best to set up Slide Master first before creating individual slides – this can save 
time as you don’t have to type the same information on more than one slide.

You want the Sub sub title to move down 
a level so that it is on a different level from 
the subtitle (that is, you want to decrease its 
importance). Select that line of text then right-
click and select Demote. Alternatively press the 
Tab key. The Sub sub title has now moved 
to the right and the format of the bullet has 
changed from • to ‑.

Example:
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ADMINISTRATIVE THEORY AND PRACTICE

Gantt charts track progress 
on a project over time.

Let’s now look at an example of each.

Gantt chart

This is a chart that allows individuals to see at a glance key dates and tasks and to 
monitor when tasks have been completed. The Gantt chart below plots the time plan 
horizontally and the tasks to be completed vertically.

Priorities lists

A priorities list is very similar to a to-do list. In this type of list, however, tasks to be 
completed are prioritised so that more urgent tasks are undertaken first. Employees 
usually also estimate how much time each task will take to complete and this helps 
ensure that as many tasks as possible on the list can be carried out.

PRIORITY TASK TIME CHANGES OR PROBLEMS COMPLETED/CARRIED FORWARD

1 Check and distribute incoming mail 
including e-mails

30 mins ü

4 Type up notice of meeting and agenda 
for next month’s managers’ meeting

20 mins ü

5 E-mail notice of meeting and agenda to 
all department managers and directors

10 mins Check agenda items for 
other paperwork

Started – network problems. 
Carried forward

2 Meet with departmental manager to 
discuss today’s tasks

30 mins Manager 
unexpectedly absent

Not started

3 Type up minutes of last department 
managers’ meeting

30 mins ü

WHY SET TARGETS?
There are a number of reasons why targets should be set for both individual employees 
and the organisation as a whole. Setting targets helps

•	 measure the success of an organisation
•	 managers organise their resources (both financial and human)
•	 all employees to understand what the organisation wishes to achieve
•	 all employees to understand their role in the organisation
•	 employees to measure the success of their work compared with the original targets set

It is very important within any organisation that staff share the management’s vision. One of the 
duties of the Senior Administrative Assistant is to set both personal and departmental targets 
to enable the organisation to meet its long-term aims and objectives. Departmental targets will 
only be achieved by employees working as a team and working towards achieving their own 
personal objectives.

SETTING TARGETS FOR THE INDIVIDUAL 
AND THE ORGANISATION 1

Here are some examples of targets a company might set:

•	 Reduce customer complaints by 20 per cent.

•	 Increase keyboarding speed from 50 words 
per minute to 75 words per minute.

•	 Increase sales by 20 per cent per quarter.

•	 Maintain a clear and tidy workstation.

•	 Reduce time taken to file documents.

•	 Reduce unnecessary photocopying to try to 
reduce administrative costs.

Example: Targets

‘SMART’ TARGETS
It is not enough to simply set targets – targets need to be SMART!

S Specific – The target must be well defined and state exactly what is required or is to be achieved.

M Measurable – It must be quantifiable and be expressed in some form of measurement unit, for example, increase sales 
by 20 per cent.

A Agreed – The target must be discussed and agreed with your line manager, especially when preparing your personal 
development plan (PDP).

R Realistic – Targets should be challenging but must still be achievable.

T Timed – It is important that key dates identify when the target should be completed.

PLANNING AIDS
Target setting (both at individual and organisational level) will be based on a number of 
factors and should be recorded and monitored using a variety of different documents 
such as those shown in the table below.

A number of planning aids 
can be used to record and 
monitor targets.

This Gantt chart shows the planning and organising of a jobs fair over a 13-week period.

ACTIVITY/WEEK 1 2 3 4 5 6 7 8 9 10 11 12 13

Create database of local businesses, colleges and 
training agencies

Research and book a suitable venue for the jobs 
fair conference

Prepare an itinerary for the one-day event

Send letters of invitation to potential delegates

Prepare publicity materials and distribute

Update database with delegate responses and 
their requirements

Plan layout of room and produce guides for job-seekers

Source potential caterers and budget for catering costs

Prepare evaluation forms for both delegates 
and job-seekers

Update database from information on evaluation forms

Example:

For more activities on 
setting targets, head to 
www.brightredbooks.net

Head to  
www.brightredbooks.net 
and test your knowledge  
of setting targets.

NAME OF DOCUMENT DESCRIPTION

Gantt chart This is used by project managers to show comparisons between work planned and work accomplished in relation to time schedules. It 
looks a bit like a bar chart.

To-do list Usually a note to yourself to show a list of tasks that need to be completed. These may be pre-printed to-do lists or simple sticky notes 
or sheets of scrap paper.

Priorities list Similar to a to-do list but this time put in order of priority showing which task needs to be tackled first, which second and so on.

Action plan A document that identifies what should be done by whom, with expected completion dates.

Electronic 
diary (e-diary)

Useful for arranging meetings as days, weeks and months can be seen at a glance, and the e-diaries of all participants can be seen 
at the same time. Most e-diaries have electronic task lists which aid planning and organisation.

Personal 
development plan

A formal document that allows an employee to record areas of strength and areas where training and development are required. 
This helps the employee to meet targets set. Some organisations also encourage employees to record personal aims. Although not 
a requirement of the job, these may enhance the employee’s confidence and well-being.

You are an Administrative Assistant at Campbell and Clark Ltd.

Simon Gregg, the Human Resources Manager, wishes to highlight to all staff the impact 
that time stealers can have on their workflow and suggest possible measures that staff 
can take to avoid them.

He has asked that you prepare a short PowerPoint presentation outlining six time stealers 
and strategies that staff can use to address them. Make your presentation as informative 
as possible and forward to Mr Gregg for approval.

contd

Approximately 100 delegates 
to attend.
All activities are expected to 
begin at their earliest start time.

Work to be completed

Completed work
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ADMINISTRATIVE THEORY AND PRACTICE
Secretary 
(Administrative 
Assistant) – cont’d

• � Arrange with the switchboard to re-route calls or take messages during the meeting

• � Place a “Meeting in Progress” sign on the door of the meeting room

During the meeting the Administrative Assistant is responsible for:

• � Assisting the Chairperson by distributing files or documents

• � Making sure all present sign the register and read the minutes of the previous meeting

• � Taking notes summarising proceedings so that the minutes can be drafted 

• � Distributing any expense claim forms

After the meeting the Administrative Assistant is responsible for:

• � Removing the “Meeting in Progress” sign and tidying the room

• � Preparing draft minutes from the notes taken as soon as possible after the meeting 

• � Making a note of the date of the next meeting in own diary and Chairperson’s diary

• � Writing any letters as required from the meeting

• � Contacing attendees who have actions from the meeting to check that they are comfortable with what they have to do

• � Preparing and send out evaluation forms if necessary to all those present at the meeting

Treasurer The Treasurer is responsible for preparing financial statements and reports and presenting this information at the meeting.  In business, the 
Finance Director or Senior Accountant would undertake this role.

INTRODUCTION
A meeting is a gathering together of people for a purpose and meetings 
take place in all organisations. The main purposes are to:

•	� discuss and 
generate ideas

•	� consult on issues and 
solve problems 

•	 motivate staff and for team building 

•	 delegate tasks and responsibilities 

•	 set targets and objectives

•	 plan and make decisions.

If a meeting is necessary, then it must be well organised and run to 
be effective.

Principles for Effective Meetings

1.	 Plan the meeting first – is it absolutely necessary?

2.	 Make sure it has a clear purpose.

3.	 Prepare an agenda and circulate before the meeting.

4.	 Set a time limit for the meeting to last, for example, 1 hour.

5.	 Delegate responsibilities, keep control and agree outcomes and actions.

6.	 Follow up on agreed actions.

Meetings range from an informal chat between colleagues to the organisation’s formal 
Annual General Meeting (AGM).

MEETINGS

The Administrative 
Assistant has duties to 
perform before, during and 
after a meeting.

A poorly organised 
meeting reflects badly on 
the organisation and the 
Administrative Assistant.

Test yourself on meetings 
at www.brightredbooks.net

Meetings must be 
well organised.

Meetings can be formal 
or informal.

The key office bearers are: 
Chairperson, Secretary 
and Treasurer.

FORMAL MEETINGS
To ensure that a formal meeting is valid (legal) it is important for it to be:
1.	 Properly convened – appropriate notice given to every person entitled to attend
2.	 Properly constituted – the Chairperson and quorum (minimum number of people 

allowed to attend) must be present
3.	 Held in accordance with rules and regulations governing the conduct of meetings.
Formal meetings are likely to have three office bearers who will be assigned key roles and 
responsibilities. These are outlined below:

Office Bearer Outline of Role/Responsibilities

Chairperson • � Keeping order at a meeting and generally taking charge of the meeting

• � Making sure that the meeting is set up and run according to the organisation’s Standing Orders

• �� Compiling the agenda

• � Ensuring that the previous minutes of meeting are correct

• � Ensuring there is a minimum number of people present to start the meeting (a quorum)

• � Starting and closing (adjourning) the meeting on time

• � Ensuring discussion is kept to the point and working consistently through the agenda 

• � Ensuring everyone has the opportunity to speak 

• � Deciding when it is time to vote, and declaring the result of a vote

Secretary 
(Administrative 
Assistant)

Providing administrative support before, during and after the meeting.•
Before the meeting the Administrative Assistant must:

• � Book the venue/accommodation for the meeting and ensure good room layout

• � Order refreshments, taking account of special dietary requirements 

• � Book any equipment that may be needed

• � Inform reception where the meeting is and arrange for parking spaces/permits 

• � Distribute the approved notice of meeting and agenda to members entitled to attend 

• � Prepare an attendance register and name cards for the attendees – if necessary

• � Ensure minutes of previous meeting are sent out in advance and are also available at the meeting

contd

CONSEQUENCES OF POORLY PLANNED MEETINGS
When a meeting has not been well organised it reflects on the 
organisation and the person responsible for organising the 
meeting – the Administrative Assistant.

•	 The meeting may be postponed, particularly if attendees 
have not received the meeting papers or the agenda with 
sufficient notice.

•	 A badly designed agenda may lead to time wasting and the 
meeting taking longer than necessary.

•	 If attendees have not received the minutes or papers for the 
meeting in sufficient time they might not have time to read 
them, so might not be able to join the discussion. 

•	 If the venue has not been booked or is double booked the 
meeting may not take place.

•	 An attendee may be embarrassed, or even angry, if the food provided is not suitable.

•	 If parking has not been arranged, or if there is no disabled access, it may result in 
attendees being late (and annoyed).

•	 If the correct meeting procedures have not been followed, then any decisions taken at 
the meeting could be invalid.

•	 People attending the meeting could feel that their time has been wasted – and time in 
business is money!

1.	 Justify the need for an effective chairperson at a meeting.� (2 marks)
2.	 Outline the use of two documents relating to a formal meeting and  

justify their importance.� (2 marks)
3.	 Explain the consequences of failing to plan and organise effectively for  

a meeting.� (4 marks)
4.	 Describe the role of an Administrative Assistant before a meeting 

takes place.� (4 marks)
5.	 Justify the use of remote meetings.� (2 marks)
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